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QUESTION NO: 1 

IBM Tivoli Endpoint Manager for Software Usage Analysis V1.3 users are divided into four
essential roles. What are they?

A. Administrators, Users, Read Only, Operators 
B. Administrators, Operators, Users, DBAdmins 
C. Operators, Master Operators. Administrators, DBAdmins 
D. Administrators, Catalog Editors, Contract Editors, Normal Users 

Answer: D  

QUESTION NO: 2 

The IT operations team wants to install IBM Tivoli Endpoint Manager (TEM) in a network where
proxy Internet access is required. The proxy requires a non-Windows credential to be entered
each time the Internet is accessed. Where is this registry key set:
[HKEY_LOCAL_MACHINE\SOFTWARE\BigFix\Enterprise ServertGatherService]?

A. On the TEM server 
B. On the Top Level Relay 
C. On the Internet DMZ relay 
D. On a client with direct Internet access 

Answer: A  

QUESTION NO: 3 

Which tool does IBM Tivoli Endpoint Manager use to discover assets on a network(s)?

A. Nmap 
B. Wireshark 
C. IBM Tivoli Network Node Manager 
D. IBM Tivoli Asset Discovery for Distributed 

Answer: A 
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QUESTION NO: 4 

What is the IBM Tivoli Endpoint Manager (TEM) Maintenance Window Dashboard used for?

A. To perform maintenance on the TEM database 
B. To schedule hardware maintenance, when required, on the TEM server 
C. To define time windows in which TEM will perform actions on target systems 
D. To determine when the TEM server will be unavailable due to required maintenance 

Answer: C 

QUESTION NO: 5 

By default which TCP port needs to be opened on the external firewall to allow an Internet-based
client to reach the Internet DMZ relay?

A. Port 80 inbound to the relay with return traffic allowed 
B. Port 52311 inbound to the relay with return traffic allowed 
C. Port 80 inbound to the relay with return traffic allowed / outbound to the client with return traffic
allowed 
D. Port 52311 inbound to the relay with return traffic allowed / outbound to the client with return
traffic allowed 

Answer: B 

QUESTION NO: 6 

Power Management has recently been added to the IBM Tivoli Endpoint Manager (TEM) license.
What is the first step to view the site contents in the console?

A. Launch the TEM Administration Tool and enable the site under the Masthead Management tab 
B. Choose the Power Management site from the external site listing and specifically subscribe the
TEM server 
C. Choose the Power Management site from the external site listing and subscribe any Windows
computer 
D. Enable the Power Management site under the License Overview dashboard within the BigFix
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Management domain 

Answer: D  

QUESTION NO: 7 

Which two non-Windows operating systems are supported for IBM Tivoli Endpoint Manager
relays? (Choose two.)

A. zLinux 
B. HP-UX 
C. Mac OS 
D. Solaris 10 
E. Red Hat Enterprise Linux 

Answer: D,E 

QUESTION NO: 8 

How are systems added to a Manual Group within the IBM Tivoli Endpoint Manager Console?

A. Drag and drop the computer into the Manual Group 
B. Drag and drop the Manual Group onto the computer 
C. Right-click the computer and choose Add to Manual Group 
D. Right-click the Manual Group and choose Add Computer to Manual Group 

Answer: C 

QUESTION NO: 9 

In the IBM Tivoli Endpoint Manager (TEM) Console under the Debug menu, which option allows
the testing of a session relevance statement?

A. Fixlet Debugger 
B. TEM Diagnostics 
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C. Domain Debugger 
D. Presentation Debugger 

Answer: D 

QUESTION NO: 10 

What is a supported database platform for IBM Tivoli Endpoint Manager V8.2?

A. Oracle 9i 
B. IBMDB2 9.2 
C. MySQL 5.5.20 
D. Microsoft SQL Server 2008 

Answer: D 

QUESTION NO: 11 

By default, when will Automatic Relay Selection on the client occur?

A. Upon every reboot 
B. Once every 6 hours 
C. Once every 24 hours 
D. Once every 12 hours 

Answer: B 

QUESTION NO: 12 

Which file(s) does an IBM Tivoli Endpoint Manager (TEM) client need to download as part of an
action to migrate from one TEM server to another?

A. License certificate of the new TEM server only 
B. New TEM server master operator private key files 
C. Action Site Masthead of the new TEM server only 
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D. License certificate of the old TEM server and license certificate of the new TEM server 

Answer: C 

QUESTION NO: 13 

How is the BES Gather Service configured to use a service account?

A. Edit the properties for the BES Gather Service and set the service to Log on as: to use the
service account service account ID and password 
B. Make a custom copy of BES Support task 125 and in the custom copy edit the action script with
the account information, save the custom copy to the Master Action Site, and deploy to the main
TEM server 
C. During the deployment planning phase the IBM Tivoli Endpoint Manager (TEM) sales person
should have provided a custom BESGatherService.vbs file; run the vbs file on the TEM server to
configure gathering 
D. Open the Windows Registry on the TEM server, go to
HKEY_LOCAL_MACHINE\SOFTWARE\BigFix\Enterprise Server/GatherService, and set the
String Value Logon Info to use the service account name and password 

Answer: A 

QUESTION NO: 14 

Which dashboard can be used to check the number of unreachable endpoints?

A. License Overview 
B. Deployment Overview 
C. Client Health Overview 
D. Deployment Health Checks 

Answer: D 

QUESTION NO: 15 

Which action must be taken to configure the IBM Tivoli Endpoint Manager (TEM) BES Server
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Plugin Service to access the Web Reports SOAP API?

A. Run the TEM task Enable Web Reports SOAP API 
B. Setup the appropriate registry settings for the SOAP username, password, and URL 
C. Access the TEM Administration Tool to modify the Masthead to enable the Web Reports SOAP
API 
D. Access the TEM Console as a master operator and select File > Preferences and enable the
Web Reports SOAP API 

Answer: B 

QUESTION NO: 16 

Internet access must be configured through a proxy server in order for the IBM Tivoli Endpoint
Manager (TEM) server to download Windows patches from the Internet. How is this
accomplished?

A. The TEM server does not need Internet access. Content can only be added manually. 
B. Configure the BES Gather Service to use a service account that has open access to the
Internet. 
C. Configure specific proxy server rules only permitting the TEM clients to go to specific domains
such as Microsoft.com or Adobe.com. 
D. In the Window's registry set the BES Gather Service to bypass proxy server for local address.
Restart the BES Gather Service when finished so changes will take effect. 

Answer: B 

QUESTION NO: 17 

How is an IBM Tivoli Endpoint Manager (TEM) client system most efficiently promoted to a relay?

A. Manually run the reiayinstaill.exe package on the desired system 
B. All TEM clients are already relays so no additional configuration is necessary 
C. Use the relay install task from the TEM Console to install the relay on the desired system 
D. Create a fixlet using the TEM Software Distribution tool to distribute and execute the relay
install on the desired system 

Answer: C
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QUESTION NO: 18 

For a scheduled activity in the IBM Tivoli Endpoint Manager (TEM) Web Reports that has Archive
selected as the activity action, where does the archive information get stored by default?

A. It gets e-mailed to TEM Web Reports admin 
B. In the main TEM server database (BFEnterprise) 
C. In the TEM Web Reports database (BFReporting) 
D. On the file system of the TEM Web Reports server 

Answer: D 

QUESTION NO: 19 

This action script is run: 

regset "[HKEY_CURRENT_USER\Software\Test]" "testString" = "testValue"

In the fixlet debugger, the key gets correctly created under the HKEY_CURRENTJJSER branch.
However, when running the same action by targeting the IBM Tivoli Endpoint Manager (TEM)
client in the TEM Console, the agent states that the action ran to completion but the same key is
not there. What is the reason for this discrepancy?

A. The TEM client reported action completion in error. 
B. Some action script commands, like regset, work only in the fixlet debugger. 
C. The fixlet debugger is more forgiving when it comes to proper action script form. 
D. The fixlet debugger runs under the users' context; the TEM client runs as LocalSystem. 

Answer: D 

QUESTION NO: 20 

The Message Level Encryption feature of IBM Tivoli Endpoint Manager V8.2 (TEM) increases
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security but adds an additional load to the environment. What system hardware changes should
be made to the TEM environment to accommodate the additional load?

A. Add more RAM to the relays and clients 
B. Add more disk space to the TEM server and clients 
C. Add more RAM to the TEM server or decrypting relay 
D. Add more processing power to the TEM server or decrypting relay 

Answer: D 

QUESTION NO: 21 

An action contains this action script command: 

Action may require restart

What does this action command do?

A. It sends a notification to the user logged into the system that the system will reboot. 
B. It sends a notification to the user logged into the system to check if the systems is in need of a
reboot. 
C. At the end of the action, the IBM Tivoli Endpoint Manager (TEM) client checks if the system is
in a pending restart state. If yes, the agent restarts the system 
D. At the end of the action, the TEM client checks if the system is in a pending restart state. If yes,
the client reports back with Pending Restart. 

Answer: D 

QUESTION NO: 22 

Which account should a remote console operator use to access the IBM Tivoli Endpoint Manager
(TEM) Console?

A. LDAP/AD Domain credentials 
B. TEM Masthead and password 
C. SQL Server Admin credentials 
D. TEM Private Key and password 
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Answer: A 

QUESTION NO: 23 

Lee is an IBM Tivoli Endpoint Manager (TEM) engineer who has master operator credentials. Lee
created a non-master operator account for Bob, an engineer on the same deployment with a
responsibility to patch all Windows endpoints. Bob mentions all fixlets in the Patches for Windows
site are showing 0/0 applicable computers. Lee checks the site and sees that there are over 5,000
computers subscribed to the site. What step did Lee miss when he set up Bob's account?

A. Lee should have created a master operator account for Bob. 
B. Lee did not subscribe Bob's account to the Patches for Windows site. 
C. Lee did not give Bob the correct key/password credential set for the console. 
D. Lee did not assign management rights to Bob's account for the computers he needs to
manage. 

Answer: D 

QUESTION NO: 24 

What is a valid reason to take an action as a policy?

A. An operator needs to be notified upon a failure. 
B. An operator needs to define the criteria for applicability. 
C. An operator needs to keep the anti-virus definition up to date. 
D. An operator needs to deploy an application to one system within one day. 

Answer: C 

QUESTION NO: 25 

The IBM Tivoli Endpoint Manager (TEM) server is slow to report client status, and in the
Deployment Health Checks Dashboard the Bufferdir file counts are elevated with no other issues
in warning or marked as critical. What are two actions that can be taken to improve BES FillDB
service performance? (Choose two.)
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A. File compression should be disabled. 
B. Windows file indexing should be turned off. 
C. The BES Root Server service should be restarted. 
D. Both the BES FillDB service and Root Server service should be restarted. 
E. Windows or third party firewall rules are allowing inbound communication on the TEM port. 

Answer: A,B 

QUESTION NO: 26 

BES FillDB can occasionally get backed up. One common cause is all IBM Tivoli Endpoint
Manager (TEM) clients send a full report at the same time which overwhelms BES FillDB with
more data than it can process in a timely fashion. Which statement describes an action that would
cause this scenario to occur?

A. The BES FillDB service account is in a locked-out state. 
B. A TEM operator deployed a large baseline to all computers. 
C. A TEM operator activated an analysis in the middle of the day. 
D. A TEM operator initiated a force refresh action to all computers. 

Answer: D  

QUESTION NO: 27 

Which statement describes the process of enabling the client dashboard for IBM Tivoli Endpoint
Manager (TEM) for Power Management?

A. Log into the client, right-click on the client dashboard icon in the tool tray, and select the option
Enable Power Management Dashboard 
B. Access the TEM Administration tool, select System Options, under the Client section select the
option Enable Client Dashboard for Power Management 
C. Access the TEM Console, under All Content domain select computers folder, right-click on the
agent, and select Enable Client Dashboard for Power Management 
D. Access the TEM Console, select the Systems Lifecycle domain, select the Power Management
folder, select Setup and Configuration, and take action on the task Enable Client Dashboard 

Answer: D 
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QUESTION NO: 28 

Which statement describes how to manually set download throttling for clients within IBM Tivoli
Endpoint Manager (TEM)?

A. Access the relay diagnostic page on the TEM server at http://127.0.0.1:52311/rd and modify the
Client Download Speed setting. 
B. Access the TEM console, take action on the task BES Client Setting: Download Throttling, in
the Action Parameter window set the Bytes/sec value, and click OK. 
C. Access the TEM console, select File > Preferences, under the bandwidth throttling section,
update the Bytes/sec value for the default download throttling for clients. 
D. Access the TEM Administration Tool, select System Options, select bandwidth throttling, and
update the Bytes/sec value for the default download throttling for clients. 

Answer: B 

QUESTION NO: 29 

Which statement is true regarding the BES Client Setting: Enable Debug Logging task?

A. The client must accept the action offer. 
B. The client service must be restarted for logging to begin. 
C. The site administration Private Key password must be entered. 
D. The level of detail must be entered for the BES Client debug log in an action parameter. 

Answer: D 

QUESTION NO: 30 

Which API is available to pull computer result data from IBM Tivoli Endpoint Manager (TEM) Web
Reports?

A. SOAP API 
B. TEM Platform API 
C. TEM Client Compliance API 
D. TEM Web Reports Database API 
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Answer: A 

QUESTION NO: 31 

What service must be installed on the IBM Tivoli Endpoint Manager server before the Manage
Software Distribution Packages dashboard can function?

A. BES Gather Service 
B. BES Server Plugin Service 
C. BES Content Provider service 
D. BES Software Distribution Agent service 

Answer: B 

QUESTION NO: 32 

Which language is used when creating a new analysis?

A. Javascript 
B. Relevance 
C. Action Script 
D. Session Relevance 

Answer: B 

QUESTION NO: 33 

All non-master operators in an IBM Tivoli Endpoint Manager (TEM) installation cannot see recent
content. What is the likely issue?

A. Default fixlet visibility has been set to globally hidden by the TEM site administrator. 
B. The fixlet BES Console setting Hide Content by Site has been run by a master operator. 
C. Non-master operators stored in the database have become corrupt and will have to be
recreated. 
D. A custom install of the console has required that a master operator decide which content is
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visible to non-masters. 

Answer: A 

QUESTION NO: 34 

What is a difference between a Retrieved Property and an Analysis Property?

A. The time frame used in reporting the results. 
B. Only a non-master operator can create a Retrieved Properly. 
C. A Retrieved Property reports with each heartbeat while an Analysis Property only reports when
the value changes. 
D. A Retrieved Property is global in nature whereas the scope of an Analysis Property is based on
the operator's computer visibility. 

Answer: D 

QUESTION NO: 35 

By default, what is a relay's secondary relay, if not otherwise defined?

A. The main IBM Tivoli Endpoint Manager (TEM) server 
B. A random TEM client on the same subnet 
C. Its_BESCIient_Relay_NameOverride relay setting 
D. The next closest relay as defined by the network hop count 

Answer: A  

QUESTION NO: 36 

After running IBM Tivoli Endpoint Manager (TEM) server installer and installing only the TEM Web
Reports server component, a user tries to log into TEM Web Reports by running Google Chrome
on the TEM Web Reports server. However, the TEM Web Reports page cannot be displayed in
the browser. What is the source of this problem?
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A. BES Web Reports Server service is not properly configured. 
B. Google Chrome is not a browser supported by TEM Web Reports. 
C. The user must use their active directory credentials for their initial login to TEM Web Reports. 
D. TEM Web Reports cannot be installed stand-alone, other main TEM server components are
required 

Answer: A  

QUESTION NO: 37 

What action needs to be performed by a master operator to allow a non-master operator account
to create a custom site?

A. Set the Unmanaged Assets right to Show All 
B. Grant custom content rights to the non-master operator 
C. Grant master operator privileges to the non-master operator 
D. Assign all computers in the environment to the non-master operator 

Answer: C  

QUESTION NO: 38 

A customer has a functioning IBM Tivoli Endpoint Manager (TEM) server and has successfully
deployed TEM for Core Protection Module (CPM) in their network. They want to use Trend's Web
Reputation technology so that they can have real time and control to prevent Web-based malware
from infecting their end users' computers. What do they need to do to get this process started?

A. CPM does not have Web Reputation capability. 
B. Take action on the task Set URL Filtering on the end users' computers. 
C. Ensure CPM clients are at V10.6 or greater. Take action on the Core Protection Module -
Endpoint Upgrade task. 
D. Take action on the task Enable Web Reputation on the Proxy Server to enable communication
between CPM and the proxy. 

Answer: C  
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QUESTION NO: 39 

After deploying 100 Windows agents using the Client Deployment Wizard, none of the agents are
showing up in the IBM Tivoli Endpoint Manager (TEM) Console. The Client Deployment Wizard
shows that the agent was installed and the agent is running on all 100 systems. The agent is
running on the TEM server and the one agent appears in the TEM Console. What are the two
most likely causes of this problem? (Choose two.)

A. There is no DNS entry for the TEM server. 
B. The Windows firewall is active on the client system. 
C. Port 52311 is not open from the client to the TEM server. 
D. The agent install was performed with insufficient credentials. 
E. The agent install actually failed even though the Client Deployment Wizard shows success 

Answer: A,C 

QUESTION NO: 40 

The number of clients connecting directly to any one given Windows relay should be no more than
what value?

A. 500 
B. 1000 
C. 2000 
D. 5000 

Answer: B 

QUESTION NO: 41 

An action script within a software install fixlet contains this action script line:

prefetch a.exe shal: 0123456789012345678901234567890123456789  size:11723

http://download.ibm.com/z.exe

An action is issued from this fixlet targeting an IBM Tivoli Endpoint Manager (TEM) client reporting
to a TEM relay that is in turn reporting to the main TEM server. What does the TEM client do when
running this action script line?
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A. It requests the file a.exe directly from the TEM server. 
B. It goes out to http://download.ibm.eom/z.exeto get the file. 
C. It requests the file z.exe from the TEM relay it's reporting to. 
D. It waits for the main TEM server to push an .exefile down to it. 

Answer: C 

QUESTION NO: 42 

Which tool must run on an Internet-connected system to download patches and other files to
deploy from the IBM Tivoli Endpoint Manager Server in an air-gapped network?

A. BESGather Utility 
B. BESAirgapTool.exe 
C. BES Remote Patch Utility 
D. BES Download Cacher Utility 

Answer: D 

QUESTION NO: 43 

What is the purpose of the Gathering Interval drop-down menu setting in the Advanced Masthead
parameters within the IBM Tivoli Endpoint Manager (TEM) Administration Tool?

A. This option determines how often new content is replicated to relays. 
B. This option determines how often the server gathers new content for the sites. 
C. This option defines how often server replication occurs between two TEM servers. 
D. This option determines how long the clients wait without hearing from the server before they
check whether new content is available. 

Answer: D 

QUESTION NO: 44 

When planning an IBM Tivoli Endpoint Manager V8.2 deployment it is very important to properly
configure the RAID controller for optimal performance. What is the recommended RAID cache
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performance setting?

A. 100% read. 0% write 
B. 50% read, 50% write 
C. 75% read. 25% write 
D. 0%read. 100% write 

Answer: B 

QUESTION NO: 45 

After installing a new IBM Tivoli Endpoint Manager Server to setup for DSA replication, what is the
default replication cycle set to?

A. 1 day 
B. 1 hour 
C. 12 hours 
D. 5 minutes 

Answer: D 

QUESTION NO: 46 

What is the BES Root Server Service used for?

A. It is used to replicate database information when DSA is implemented. 
B. It runs a unique version of Apache and is one of two services required to run Web reports. 
C. It runs as the root account and allows IBM Tivoli Endpoint Manager to install software and
patches on UNIX and Linux computers. 
D. It provides http and https services to support data transfer between the relays and clients as
well as between the console and database. 

Answer: D 

QUESTION NO: 47 
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Local console operator password policies can be set in IBM Tivoli Endpoint Manager V8.2 (TEM).
Where are these policies set with the TEM environment?

A. At the time of install using the install generator 
B. Within the console using console preference settings 
C. The Advanced Options tab within the TEM Administration Tool 
D. Within the console in the settings dialog for each individual operator 

Answer: C 

QUESTION NO: 48 

How is a custom analysis created from the IBM Tivoli Endpoint Manager Console?

A. Tools > Create New Analysis 
B. Run the Create New Analysis task 
C. Run the Create New Analysis Wizard 
D. Custom analyses cannot be created, only edit the analyses provided by IBM 

Answer: A 

QUESTION NO: 49 

Which method allows a Windows patch to be uninstalled from a Windows endpoint?

A. Use the File Pre-Cache Wizard 
B. Use the Software Distribution Wizard in Uninstall mode 
C. Take action on the corrupt version of the fixlet that installed the patch 
D. Take action on the task created by the Microsoft Patch Rollback Task Wizard 

Answer: D 

QUESTION NO: 50 

How can a custom setting be created for a computer?
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A. Run the Add Client Custom Settings fixlet 
B. Run the Add Client Custom Settings wizard 
C. Use the Custom Setting dialog in the Edit Computer Settings dialog window 
D. By assigning a retrieved property to a computer in the Edit Computer Settings dialog window 

Answer: C 

QUESTION NO: 51 

When using Relay Affiliation, which relay selection process must be used on the clients?

A. Site relay selection 
B. Group relay selection 
C. Manual relay selection 
D. Automatic relay selection 

Answer: D 

QUESTION NO: 52 

Which two steps must be performed in order to enable Message Level Encryption within a
standard IBM Tivoli Endpoint Manager (TEM) environment? (Choose two.)

A. Generate the encryption key 
B. Encrypt the TEM BFEnterprise database 
C. Encrypt the action site folder on the endpoints 
D. Take action on the task- BES Client Setting: Encrypted Reports to the endpoints 
E. Take action on the task - Enable Encrypted Password Deployment to the endpoints 

Answer: A,D 

QUESTION NO: 53 

Which statement would make a fixlet applicable only to systems that do not have Adobe Acrobat
Reader installed or have Adobe Acrobat Reader with version less than 9?
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A. Exists regapp "acrord32.exe" whose (version of it < "9") 
B. Not exists regapp "acrord32.exe" whose (version of it >= "9") 
C. Exists regapp "acrord32.exe" AND version of regapp "acrord32.exe" < "9" 
D. Not exists regapp "acrord32.exe" AND version of regapp "acrord32.exe" < "9" 

Answer: B 

QUESTION NO: 54 

What is the best use of a baseline within IBM Tivoli Endpoint Manager (TEM)?

A. To deploy a set of Analyses 
B. To compare multiple systems 
C. To deploy a single software package 
D. To maintain or level set a group of devices that need the same packages 

Answer: D 

QUESTION NO: 55 

Which two conditions must be satisfied for an IBM Tivoli Endpoint Manager (TEM) client to appear
in the TEM Console for a non-master operator? (Choose two.)

A. The TEM client has to be subscribed to BES Support site. 
B. A non-master operator has to have read rights over the BES Support site. 
C. A non-master operator must have the Unmanaged Assets right set to Show All. 
D. A non-master operator must be granted a right to administer the TEM client by a master
operator. 
E. The TEM client has to be able to evaluate and report back on management rights assignment
actions. 

Answer: D,E  

QUESTION NO: 56 

Where is a user added to grant access to IBM Tivoli Endpoint Manager (TEM) Web Reports in a
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